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Syswin subjects: 
 

Background to Omron development software, LSS and Syswin 
 
1. The LSS programming environment 

 
2. The Syswin programming environment 

    Setting up and communications 
    File handling SWP/SWB and loading a program from disk 
    Converting an LSS program from disk 
    Syswin versions and incompatibility 
    The desktop environment 
    Networks and Blocks, inserting and deleting 
    Copy, Paste, and Undo 
    Writing a small program 
    Checking the program for errors 
    Saving the program 

 
Using Syswin 
1) Connecting to a PLC 

(i) CIF cable, the danger of leaving a CIF cable connected 
(ii) RS232 lead and its connections 
(iii) Communication setup 

 
2) Downloading to a PLC with Syswin 
3) Setting the PLC to Run Mode 
4) Monitoring the program 
5) The Data Set bar 
6) The Data editor 
7) Disconnecting 
8) Re-Connecting and Program Verify 
9) Uploading to a blank Syswin 
10) Comments and the PLC 
11) Importing comments 
12) Finding used addresses 
13) On Line Edit and its dangers with complex programs 
14) The dangers of deleting networks and how they affect network comments 
15) Set and Force and its dangers 
16) Finding active Forces 
17) Turning off rungs 
18) By-Passing sections 
19) Uploading/Downloading Data Memory values and Saving 
 
20) Omron PLC addressing types 

(i) General Bits and Bytes, First Scan, On & Off, 1sec Pulse 
(ii) HR 
(iii) DM 
(iv) Timers and Counters 
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Background to the Omron Programming Environment: 

 
 
 
 
LSS 
This is a Dos based program, introduced by Omron it replaced the FIT terminal and allowed laptops or 
desktop PC's to be used to communicate with Omron PLC's. 
 
LSS programming tool is still very popular among engineers due to its straight forward approach to setting 
up, also its strong use of easily identifiable keystrokes which greatly secure the programming environment 
against errors, mainly caused through slight mishaps when using a Laptop TouchPad or Mouse in a 
Windows environment. 
 
Programs written in LSS are saved in what is called a Library file, these files can be just over a megabyte in 
size and store a number of programs for varying PLC’s. The Library file can easily be found as it tends to 
be stored in the LSS directory or on a floppy disk and has the extension ‘.dat’. 
 
LSS is an old programming tool, written some years ago when Dos stilled ruled the computer operating 
systems, it communicated with Omron’s older generation of PLC’s: C200H, C20, C1000H etc. As 
Windows gained popularity it was inevitable that Omron would follow or take the lead amongst other PLC 
manufacturers and develop new software tools along these lines, the expansion of LSS to cater for newer 
PLC’s was not undertaken apart from introducing one final Dos based program called CVSS which had 
some extra features such as programming memory cards that could be used in the new Omron CV series. 
CVSS was probably developed as an after thought since PLC development continued at a rapid pace and a 
development platform was required urgently to aid the customer with the new PLC features, however very 
soon after this Syswin was born and further support for LSS and CVSS was phased out. 
 
 
 
Syswin 
Syswin was developed during the early nineties when Windows 3.1 was the computer Operating System. 
Unfortunately technology raced ahead at such a pace, that when Syswin was released Win95 appeared, and 
then Win95 was upgraded to Win98, which is now the most used Operating System in the world.  
 
Other PLC manufacturers such as Allen Bradley have developed software tools in line with Win95, so 
Omron is once again changing the development environment and has recently brought out CX programmer 
for the latest PLC generation. This software was being evaluated last year by Nissan ‘Sunderland’, 
feedback looks favorable but like all new software there will be version changes in the not too distant 
future which the engineer will need to consider when he has to use it. 
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Syswin started life as 3.0 and has progressed over the last 4years to 3.3 but more recently to moved up to 
vers3.4 which is claimed and probably will be the last version of Syswin.  
 
It is advisable to ensure that all laptops use a minimum of version 3.2, but 3.3 would be a more reliable 
environment to work with. Vers 3.0 and 3.1 should not be used. 
 
Being a Windows based environment it naturally not only looks completely different from the Dos based 
LSS, but also handles totally differently. With drop down menus and pick and place tools it is actually a 
very good PLC program development tool, however shop floor engineers tend to prefer the LSS style of 
environment, especially the LSS method of finding a specific coil which can be asked for directly whereas 
Syswin needs to go through the Cross References Menu. Other LSS benefits is its ability to display several 
rungs of program each one independent from the other. However LSS is time consuming when writing a 
program and also large programs are very difficult to follow, whereas Syswin’s Block Network Manager 
allows excellent program structuring more in line with ‘Jackson Chart Programming’. These and other 
features are covered during this course, however greater in depth training will be provided on the more 
‘Advanced Omron Course’ later. 
 
Let us begin with the Syswin environment……. 
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Syswin programming environment: 
 
 
 
 
 
 
 
 
 
 

 
 
The picture above shows a typical desktop layout. The various toolbars can be re-positioned on the screen 
by the user to suit their own preferences, this can be done via Window in the Preferences Menu. 
 
The important buttons for general programming use are shown above, all other controls and capabilities of 
Syswin will be covered in future courses. 

OnLine Edit 
Monitor Program 
Run/Stop/Monitor PLC 
Connect to PLC 
Delete network 
Insert network 
Undo  

Block network manager 
and Cross References 
 

File (Converts LSS programs) 

Data Editor (Uploading DM) and Address Symbol Editor 
Project Setup + Program Check 
Window setup 

Online (Status) 
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The window is divided into 6 main areas, these are:- 
 

1. Menu bar – top of screen, conventional windows menu style, these are drop down menus that 
provide all of the controls necessary for programming a PLC. The most important menus for 
general use are:  

a. File 
i. Convert from – converts LSS programs 

b. OnLine 
i. Upload – loads a program from the PLC, usually without comments 

ii. Download – PLC must be stopped, sends the program into PLC, usually 
without comments. 

iii. Status – PLC Error, Active Forces 
c. Project  

i. Project Setup 
ii. Program Check 

d. Block 
i. Block Network Manager 

ii. Cross references 
e. Editors 

i. Data Editor, allows sections or all of the Data Memory to be: Uploaded, 
Saved, Loaded and Downloaded. 

 
f. Preferences 

i. Window, allows user to configure the working environment layout to their 
personal preference 

ii. Options, check box allows Safety function so that all operations that affect 
the PLC will be questioned. This is highly useful for those who are 
unfamiliar with Syswin, it prevents accidentally doing something to the 
PLC. 

 
2. Tool bar – under the Menu bar, the most frequently used controls are here for quick access 
3. Drawing Tool bar – left hand side, these are all the drawing tools necessary to allow a 

program to be written: 
a. FUN – Function Blocks library and help files 
b. TIM – Standard Timer function block 
c. CNT – Standard Counter function block  

 
4. Work Area – the programming area that allows networks to be written and displayed with 

their comments. 
5. Address bar – under Work Area, shows the current address and Symbol (Name) plus 

Comment of the contact, coil, or function block clicked on. 
6. Status bar – this shows the current state the PLC is in eg: Run, Stop, Monitor and OnLine 

Edit.  
WARNING: some versions of Syswin were ‘bugged’ and displayed OnLine Edit even when 
you were not in that mode, always refer to the OnLine Edit button to see if depressed or if 
screen turns RED when editing. 
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There is one other area not shown in the picture because it has been disabled in Window Preferences and 
that is the Data Set Bar. This area allows the user to write in the address, which they wish to monitor. This 
bar can be displayed as 2 rows or 4 and is always positioned at the bottom of the Work Area (see 
Monitoring the Program). 
 
 
Activating and De-Activating Syswin: 
 
See Appendices A
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 File handling SWP/SWB and loading a program from disk 

 

 
The picture above shows the Windows Explorer. Unlike LSS where programs are stored in a .dat library 
file, Syswin programs are stored individually in any directory you wish.  As shown above, there are two 
files in the picture with the same name ‘Test.swp and Test.swb’. The important file is the SWP, the SWB is 
a backup file which is only created by Syswin when programs are being written. This backup file is not 
important and is NOT required for the engineers programming, deleting the SWB file has no effect on the 
program and is of no use to the Engineer. All Syswin needs to program a PLC or allow the Engineer to 
develop a program is the SWP file. Should you be asked to supply a copy of the PLC program, send them a 
copy of the SWP file. 
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Converting an LSS program from disk 

 
Because Syswin has to be backwards compatible, it has to be capable of reading and handling any program 
written over the years for Omron PLC’s. Therefore, even though LSS programs are Dos based and saved in 
a Library file, Syswin has the ability to read the contents of a library file and convert any programs in it to 
Syswin format. 
 
Provided you know where the LSS program is stored, Select 'Convert from' via the File Menu, a dialogue 
will appear that will ask you for the location of the .dat library file. Direct it to the correct library file. 
When the file is opened, another dialogue will show all the programs stored in that library file, select the 
type of PLC the program is for, then select the file and then load it. It will take several seconds to convert 
the program and its contents into another Syswin format called a PMF file.  
 
Once loaded if you look in the Block Network Manager via Block Menu, you will see that there are no 
network comments and that the program is loaded into one block, this is because LSS does not understand 
blocks and every program line in LSS is actually a network but LSS cannot display networks and therefore 
offers no comments. 
 
Select Save-As via the File Menu and save the new file to disk, this will now save as a SWP (Syswin 
Program) file. The PMF version on the screen will be replaced by the standard SWP file. 
This new file can be used as required and downloaded to a PLC. 
 
 
 

Syswin programs and compatibility 
Programs written with earlier versions of Syswin are Backwards compatible with version 3.3 (3.4 is 
untested at this time but should be no different). Upwards compatibility is not possible with Syswin eg 
Reading a program written in 3.3 with a 3.1 or later version, unless you save the 3.3 versions as a PMF file 
and load it into 3.1 or later as a PMF file (PMF files will be discussed on future courses and is not 
necessary for this course). LSS cannot read Syswin SWP or PMF files. Note: vers3.3 actually saves the file 
as vers3.2. 
 
However - remember this does not apply with uploading a program from a PLC, the PLC does not 
distinguish or care which version of Syswin was used, nor in fact is it bothered if the program was written 
using LSS. Uploads can be accomplished into whichever software environment is being used, Syswin or 
LSS. Note: a program written in the PLC by Syswin and then Uploaded using LSS may display on the LSS 
environment a Function Block labeled CMP(DEAD), this rung is not part of the actual working program 
but a end of Block marker. Remember Syswin writes programs not only in Networks but also Blocks. Since 
Blocks are new to LSS they are displayed with this special marker – it has no effect on the program. 
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Networks and Blocks, inserting and deleting 
The overall Block network Manager can be found in the Block Menu, this manager displays the program in 
its designed layout. A well designed program can save endless hours in fault finding (Programming 
structure will be covered in the PLC programming Course 1.0). When in OnLine Edit a shortened version 
of the Block Network Manager is displayed, the ability to Copy and Paste whole blocks is disabled. 
 

 
 
Each network shown above can contain up to approx 50 rungs of program provided they are directly 
connected to each other, the picture below shows an accepted network: 
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The following picture shows an invalid network: 

 
 
 
The error is that HR3.12 is not connected to the rungs above. Any engineer familiar with LSS, would 
assume this would be acceptable, however in LSS each rung is actually in its own hidden network and can 
be misleading because they are not shown on the LSS screen. 
 
 
 
 
 

Expanding Networks and Leaving rungs incomplete 
Syswin is fairly demanding in ensuring networks are completed correctly, however if a vertical line is left  
incomplete Syswin will erase the empty line. However incomplete horizontal lines will not be tolerated and 
a WARNING message will be given stating that the network is incomplete, the engineer will then need to 
remove the offending line or complete it if he has forgotten to finish it off. 
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If you wish to expand the network, place the cursor on the area to be expanded and press Alt+ arrow Up, 
Down, Left or Right. 
 
 

Copy, Paste, and Undo 
Syswin allows sections of program to be copied and pasted at any time. This is most useful during program 
development, and allows even full networks or blocks to be copied and pasted from other programs into the 
one being developed. However it is important to know that comments from other programs will not be 
copied, but addresses will, therefore it is necessary to check that any copied addresses will not conflict with 
the program under development, otherwise they should be re-addressed after pasting. 
 
Should an error be made while writing a program, you can Undo the errors back to the programs original 
state just after the last Save command, by pressing the Undo button with the Green arrow on it. 
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Writing a program 

Syswin allows programs to be written with a Mouse or TouchPad and also with HotKeys. The HotKey 
symbols can be found under each menu button or alongside each tool in the Drawing Toolbar. The symbols 
in the Drawing toolbar can be changed to function keys simply via Window in the Preferences Menu - 
Select Function keys in place of Alpha Keys. 
 
Before writing a new program be sure to setup Syswin for the type of PLC being used, this is done via 
Project Setup in the Project Menu. Select the type of PLC being used and ensure the correct CPU is shown 
unless 'ALL' is displayed. 

 
 
 
The other settings in Project Setup can be left at their default setting, these defaults tend to be standard for 
all PLC arrangements, unless you are dealing with complex networked PLC’s. Note if you are using a CV 
series PLC the CV Series option box also needs checking. 
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Omron PLC Function Block Library in Syswin and Help Files 

 

 
Above the User has tried to insert a function block onto the horizontal line and a popup window has 
appeared, by pressing select another window appears with a list of all the available function blocks for that 
PLC, by double clicking the required block name eg: MOV(21), this name will appear in the first window 
text area and all the user needs to do is then fill in the rest of the MOV address or values . 



PLC Programming OLplc01 
By David H Simm 

email: support@scantime.co.uk 
 

PLC / HMI & SCADA Process Control – Engineer Training – Consultancy 
 

Copyright © 2005 Scantime Engineering Ltd 

16 

 
 

 
 
 If you do not know how the MOV function block works then you can select ‘reference’ and a Help File 
will appear, explaining how it works. 
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You can now start writing the ladder program, example:- 

 
 
The Browse buttons shown above when clicked open a window that displays all the addresses and 
comments used in the current program, see ‘Finding Used addresses’ below. 
 
The contacts and coils can simply be dragged and dropped into place from the Drawing Tool bar into the 
Work Area. 
 
Note: that after selecting a Drawing Tool, its button stays depressed allowing you drop another into the 
work area, however this prevents you from selecting another network or open a previous Function block for 
addressing purposes, therefore you have to click the Arrow button at the top of the tool bar, this will release 
any depressed button and allow you to move to a new network. 
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A quick method of inserting a Function Block, can be done by dropping the FUN tool onto a work area and 
when it asks for the Function type, type into the text area the name followed by the left parenthesis eg: 
‘MOV( ‘, or type in the number if you can remember it eg: 21  = MOV(21) 
 

 
 
All you need to do now is fill in the Data 1 & 2 details. 
 
Pressing ‘Reference’ will again open the Help file for that particular function block. 
 
When addressing a contact, coil, Syswin can handle short hand, eg: 100 would be determined by Syswin to 
be 1.00, this can be useful for rapid design. In a function block remember to use the # sign when writing 
values eg  
 

 
 
The Move function above, moves the value 100 into DM 200. 
 
When you have completed your program, remember to include the 'END' statement at the very end of the 
program in its own network, otherwise an error will be displayed if you try and download the program with 
it missing.  
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WARNING – remember multiple none connected rungs are not allowed in a Syswin network. Some 
engineers confuse LSS standard of writing and displaying with that used by Syswin. LSS does not write in 
Blocks, and each rung in LSS is actually a network, although it is not as clearly shown in LSS as it is in 
Syswin. 
 
You can branch out a rung once it has started by adding further contacts and function blocks. Also rungs 
are written left to right and Syswin rungs can also end anywhere in the network. Syswin rungs can be as 
wide as you like and are not restricted to the right side of the screen as they are in LSS. 
 
Example: 

 
You can see above that the left hand side contacts are not displayed, this is because the bottom rung has 
extended beyond the window size, but the coil 5.00 has ended midway. This is very unlike LSS which ends 
all rungs on the Right Hand side. 
 
Also the function blocks above appear larger than previous examples, this is because previously I had the 
window set to display in Overview mode which is the far right hand button on the top tool bar. When 
pressed this button shrinks the Work Area so you can show more of the written program. It has no effect on 
the PLC. 
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Branching out a rung can also be done going down the screen, although there is a limit of approx 50 contact 
rungs. Function blocks take more area and therefore will be far less than 50 rungs in depth. 
 
WARNING - when writing multiple rungs within a Syswin network, Syswin will not tell you if you exceed 
the limit, you will only find this out when you try to download into the PLC and it refuses to accept it, this 
can be inconvenient, so try and be aware of how long your network has become. Rungs that are over the 
limit, will need to be removed (Cut) and (Pasted) into a new network, making sure you include the events 
prior that activate those rungs. 
 
 
 

Symbols and Comments 
Every contact, coil and function block requires an address, but a program with only addresses is very 
confusing to understand. Syswin allows every contact and coil to be given a name referred to as a Symbol.  

 
 
Above you can see that the selected contact has its address and name shown at the bottom of the screen in 
the address bar. The name (symbol) is restricted to 15 characters and must not include spaces, therefore if 
you wish to make the name more readable use an underscore ‘_’ to separate the words or type with words 
separated by a Capital letter eg: ‘PumpControl’ After typing press ‘Enter button’.  If you type in a name 
that is already used you will be warned, also if you delete a contact and try to use its name you will still be 
warned unless you have saved the program or purged the system (see Finding Used addresses section 
below). 
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The Comments text area allows you to write with spaces, but if your comment explains what that network 
does and is attached to a Function Block, then whenever you use the Function Block that is associated with 
that comment elsewhere in the program, you will have the same comment displayed there, this can be 
confusing so choose your comment carefully, or leave them out and rely on the Symbol. 
 

 
 
Be sure to press the 'Store' button when finished to commit the Comment to the work area. 
 
 
Another area for more extensive descriptions of the network can be done via Block Network Manager. 
 

 
 
Double click the Network 
 

 
  
You can enter a title for the network and a large description of the how the network operates within the 
program as a whole. WARNING: the Comment area does not undertake word wrapping, therefore consider 
this if you want the comment to be read via Block Network Manager. 
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When you Close the dialogue, your description and title will appear on the work area. 
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Checking the program for errors 

When a program has been written, it is advisable to check it not only visually but also by letting Syswin 
check it via Program Check in Project Menu. 
 

 
The check boxes checked shown above are the ones advisable, they will check most programs even if sub 
routines aren’t used.  
Duplicate Output check is always advisable, since it is very possible to double up an output coil 
unknowingly when writing a program. (Duplicate Output Coils are bad practice) 
 
Always ensure that the All Blocks option box is checked, so that it will check every line of you program. 
Press Execute to run the test. 
Any errors will be displayed in a popup window along with their location details. 
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Saving the program 

Saving can be done at anytime during program development, it is always advisable to do this every few 
minutes since Windows and PC hardware are notorious for crashing just when you don't want them to. 
Saving is done by left clicking the floppy disk button top left of screen or via Save in the File Menu. You 
also have the HotKeys option. 
 
 

Connecting to a PLC 
There are several ways to communicate with the CPU in the PLC, the most common are via 
 

• The Peripheral Port on the CPU bottom right, using a CIF or CQM lead 
• The RS232 port, left side of the Peripheral port using a standard RS232 lead 

RS232 wiring: 
     
Wiring connections: 
 

         PLC                              Laptop 
          1                                  1                   Shield 
          2                                  2                   Rx 
          3                                 3                  Tx 
          4 link to 5  Rs/Cs            4 link to 6      Dtr/Dsr 
                                              7 link to 8     Rs/Cs 
          9                                  5                   Signal Ground 

 
 

Com Port settings on the Laptop. 
Start Bits            1 
Data length         Ascii 7 bits 
Stop Bits             2 
Parity                 Even 
Baud Rate          9600 bps 
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Downloading to a PLC with Syswin 
Plug the appropriate lead into the PLC port and connect to the Com1 port on the Laptop. 
Boot Syswin on the Laptop (Syswin will try and detect the PLC type and establish a link). If it connects 
successfully the Telephone icon top right will show its handset lifted.  
 
 
 
 

If this fails check the following: 
• Go to Project Setup via Project Menu and check the correct PLC is selected. 

 
• Check the Com Port settings via Communications in the Project Menu. 

 
• Change the comms lead for another. 

 
• Change to Com2 on the Laptop and change the Communications settings to Com2. 

 
• Once connected, place the PLC into Stop Mode –  

WARNING this will stop the PLC program, ensure that the process being controlled 
is in a safe condition ie Stopped. 

 
 
 
Select Download via the Online Menu. Note a popup dialogue will appear. 
SETTINGS fill in during Course:- 
 
 
 
 
 
 
 
 
 
 
 
The program will now be downloaded, when it has finished a completed message will appear. 
 
You will now need to place the PLC into Run or Monitor mode  (both will allow the PLC 
to work as normal, however Monitor mode is used when doing OnLine edit or Monitoring 
the program with laptop). 
 
 
 
 
 
 
Note: if you omit to place the PLC into Stop mode prior to selecting Download, Syswin will automatically 
do this for you and then automatically place the PLC into Run/Monitor mode after download is complete. 
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Monitoring the program 
When connected, ensure the PLC mode is in Monitor mode, do this by pressing the button right of the 
Telephone handset and checking the Monitor Option.  
 
 
 
 
Then press the button with the Lightning Bolt symbol.   
 
 
 
This will turn from RED (Not Monitoring) to GREEN (Monitoring). 
Syswin is now in Monitor mode, any active coils and contacts will be highlighted. 
 
You can monitor DM values by typing in their address preceded with DM eg DM100, into the Data Set bar 
at the bottom of the screen 
 

 
Data Set bar: 
 
 
You can also type in other addresses, IO address 1.01 is shown as a single digit that will either be 1 or 0 
depending if the bit address is Set or Unset. 
 
When you are Monitoring a program, these values will change if the program starts altering them, you will 
also be able to change their display format, so word 0 above is shown as 4 digits, if you click on this cell 
you can select binary which then shows which Input at this slot is On or Off – this is quite useful for 
monitoring whole Input or Output cards. 
 
You can also Set and Force Set values in the Data Set Bar, more of that later! 
 
Note: If the Data Set Bar is not visible, you can display it via Window in the Preferences Menu.  selecting 
2 or 4 rows. 
Always ensure the Lightning Bolt is Green when Monitoring, if not then click the button till it turns 
green, if it does not turn Green then re-check you are still connected, 
 
 

The Data editor 
This is primarily used to monitor large blocks of addresses.  
It also allows you to Upload all or part of the Data Memory, this is important if you are about to do a test 
where the values might be change. Once Uploaded and Saved, you can after the test Download the DM 
values back into the PLC – do this after you have Downloaded the Original program back into the PLC. 
The PLC will then be back in its original state prior to the test. 
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The editor has been set to display Data Memories 0 – 1000. 
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Note when setting up and you have clicked the DM button on the left, DO NOT write DM0 – DM1000, it 
already knows it is DM you require so just type 0 and 1000. 
 

 
 
 
 

Disconnecting from the PLC 
Click on the Telephone Handset button and this will disconnect communications with the PLC, the handset 
will lower to show it is no longer connected, you can now remove the lead.   
 
 
 
 
 
The PLC can be left in either Monitor or Run mode during disconnection. 
 
WARNING: never leave a CIF lead connected to the peripheral port without a Laptop connected to it, the 
reason for this is that if the power to the PLC is interrupted, the PLC will not restart. Normally when power 
is lost to a PLC it will automatically re-start itself into Run mode. 
 
 
Never disconnect during:- 

1. A Download 
2. While an OnLine Edit is being Written to the PLC by Syswin 

 
You can disconnect during an Upload, (although it is bad practice to break any communications midstream) 
only the Upload will be useless. 
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Re-Connecting and Verify 

Boot Syswin and Load the Program from Disk 
Once you are connected to the PLC and have established a link via the Handset button. 
Select Verify - via the OnLine Menu. 
Verifying takes time, depending upon the size of program, should a mismatch be found, Syswin will show  
 

the error in Statement List format, identifying the Block and Network numbers of the location. 
 
WARNING - Verifying a program in a PLC that is running can be dangerous if the program undertakes 
very complex data handling and monitoring of very fast signals. Verification will interrupt these processes 
and could cause the process to fault. If in doubt – check! 
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Uploading to a blank Syswin 
Ensure you have established a connection. 
Select Upload via the OnLine Menu 
 

 
Note some PLC’s will not save comments due to memory space, so the program you are likely to see will 
have no comments attached. 
 
Under some circumstances it is sometimes advisable to ensure that the process is stopped, since an UpLoad 
could interfere with any High Speed signaling.  
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Comments and the PLC 
As mentioned above the PLC will possibly not store any comments from the developed program. However 
once you have an upload you can import the comments. This can be done by double clicking any contact or 
coil which will display a popup address dialogue, select Browse and the Address Symbol Editor will 
appear.  
 
 

 
Click on Load and Syswin will ask for the location of the file with the comments. 
 

 
 
Once the file has been loaded, Syswin will ask if you wish to Merge or Overwrite etc. Merge Overwrite is 
Fine for a blank program. 
 

Click here 
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Finding used addresses 
As above, after double clicking and Browse you will see the Address Symbol Editor. 
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Before you scan down the displayed list, Press Purge, this will remove any old addresses that were 
allocated but no longer used in the existing program. 
 
WARNING - do not Purge if you have removed parts of the program and intend to re-write them later, 
otherwise their comments will be lost and you will need to re-write them. 
 
 
You can now scroll through the used the addresses, with their comments. 
 
WARNING - if you double clicked a coil or contact previously to get to the Browse dialogue, DO NOT 
double click on any used address, as this will replace the coil/contact etc address previously double clicked 
in the program. The Address Symbol Editor can be accessed also via the Editor Menu or via the 
following button:  
 
 
 
 
 
 
 

Searching for specific Coil: 
Unlike LSS, Syswin searching does this differently. 
 
Select Cross Reference via the Block Menu, this will cause another dialogue to appear.  
 

 
 
 
You can type in the required address or simply scroll through the list. 
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When you click on the required address, a list will appear on the right hand side that shows where that 
address is used throughout the program. Further clicking on the right hand side will cause the screen in the 
background to change, moving you throughout the program where the address is used.  
 
If you wish to go to that part of the program press the GoTo button at the bottom of the dialogue. 
 
 
 

On Line Edit and its dangers with complex programs 
OnLine Edit allows the engineer to modify any part of the program, even add additional whole networks, 
while the PLC is running the process. 
It is the engineer’s responsibility to ensure the modification will not cause any problems to the process. 
 
Before we look at how to do an OnLine Edit, there are some other factors and dangers, which need to be 
understood. 
 

• While you are editing the program, the modification will not occur in the PLC until the correct 
buttons are pressed. That means that the modification you are doing is only taking place in Syswin 
on the Laptop, not the PLC. 

 
• The Danger occurs when Syswin starts to write the modification into the PLC program. This 

process can cause an interruption to the PLC scan time, and therefore any high speed signals may 
be lost OR any complex algorithms caused to slow down and the results be applied to the program 
too late. 

 
Therefore know your program operation before undertaking an OnLine Edit. 
 
Finally - if you have loaded a program from disk into Syswin, Verify the program as discussed earlier, this 
is to ensure that both program match. 
Alternatively, carry out an UpLoad and either import the comments or edit the program without any 
comments. 
 
Doing the Edit: 

1. Ensure a connection is established, telephone handset is raised. 
2. Locate the area for the Edit. 
3. Click the OnLine Edit button usually the 2nd from the right at top of the Syswin Toolbar, a bubble 

will appear when the cursor is over the button with the buttons name.   
 
 
 
 

OR 
You can select OnLine Edit via the OnLine Menu or via HotKeys. 

 
4. A popup will appear asking if you want to verify the program, if you have not already done so say 

YES. 
 

5. Start doing the edit in the appropriate network. 
Note: once you start editing, that part of the rung will turn RED, if it does not then you are Not 
in OnLine Edit. 

 
6. Once you have completed the edit, only the Laptop program is now altered, if you are confident 

the modification will work, then press Alt+Enter keys on the laptop. Syswin will now start writing 
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the modification only into the PLC program. When it is complete the RED areas will return to 
normal. 

 
 
 
Remember - if successful Save the modified program to disk and record how and why the program was 
modified. 
 
Click the OnLine Edit button and Syswin will return to normal. 

 
WARNING - if you forgot to Verify and the programs are different, an Error message will appear, you will 
need to do another UpLoad and start again. 
If you edit the program and forgot to press the OnLine Edit, then you should UpLoad the program again or 
Load from Disk followed by Verify, DO Not bother to Undo, this sometimes does not work and is therefore 
a waste of time, just UpLoad or Load again from Disk and Verify. 
 
Whole Networks can be deleted during OnLine Edit, this is done by pressing the Delete Network button. 
 

 
 
OnLine Editing is dangerous, therefore it is important to plan and check what you intend to do before you 
go ahead. 
 
 
 
 

Out of Sync Network Comments 
• If you delete a network OnLine without using the correct program loaded into Syswin, then 

whoever comes along later and does an UpLoad and Imports Network Comments from a file will 
find the network comments are out of sync with the correct networks. 

• The same occurs if someone alters the written Syswin program OnLine using LSS 
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Force, Set and its dangers 

This is only available when connected to a PLC. It is usual during program testing to want to Turn ON or 
OFF a contact or coil. This is called Forcing. The Omron C1000H PLC only allows one Force at a time, 
however other PLC’s eg: C200HS will allow multiple Forces.  
 
The Problems with Forcing are:- 

• It will override the present state of Coil or Contact and the program will react accordingly. 
• A Force cannot be overridden by another event eg: Forcing ON a coil will cause all contacts with 

the same address to also turn ON or OFF if a negated contact. The coil will not turn OFF if the 
coils previous conditions are OFF. 

• A Force will stay ON or OFF until it is reset   
 
WARNING - Never do a Force Reset to reset a Force Set, this will Force the coil or contact into the other 
state.  You must remove any type of FORCE with a normal Reset or Cancel All 
 
 
Setting: 
Set only will not work if the address is being controlled by the program eg: a coil cannot be Set if its event 
contacts are OFF, or a Contact cannot be Set if its address is an IO card. The reason for this is that the PLC 
scan re-calculates the rung according to the events that make up the rung and sets the coil accordingly, thus 
over-riding your Set. 
Setting is normally associated with contacts not tied to an IO card or not used anywhere else in the 
program. 
 
 
 

Finding active Forces 
This can be done after a connection is established, by selecting Status from the OnLine Menu, any active 
Forces will have the Force active check box 'checked' 
 
Turning a PLC Off/On will clear any Forces that are active, this is useful if you know a Force is present but 
do not know where it is. 
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Turning off rungs 

You may find sections in a program fitted with a Normally On or Off contact. 
 
253.13    ON 
253.14 OFF 
 
This method is normally used by engineers who do not wish to lose the designed network, but only to 
disable it for test purposes. 
 
Therefore if you wish to disable a rung, rather than fully delete it, you can do so by placing a 253.14 
Normally Off contact in series with the rung. This contact will never turn ON during the program running. 
 

 
 
 
Also if a contact or several contacts in series need to be temporarily overridden but others in the series left 
intact, then bridge the offending contacts with a 253.13 Normally On contact. Using this contact is similar 
to linking out contacts with a piece of wire in a real system. 
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The benefits if using these methods, is that the networks can be returned to their original state whenever 
required, and it also shows other engineers what has been done in the program without deleting sections. 
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Omron PLC addressing types 
         General Bits and Bytes 
         HR 
         DM 
         Timers and Counters 
 
 
C200Hx addressing: 
 

Area Size Range Comment 
Internal Relay Area 1 3776 bits IR0 to IR235 Non retentive, some special devices use this 

area 
Special Relay Area 1 312 bits SR236 to SR255 pre-configured by the PLC 
Special Relay Area 2 704 bits SR256 to SR299 flags set by the PLC 
Internal Relay Area 2 3392 bits IR300 to IR511 Non retentive, some special devices use this 

area 
Temporary Relay Area 8 bits TR0 to TR07 Used for special instruction use only 
Holding Relay Area 1600 bits HR0 to HR99 Retain their state when power is lost, can be 

used in the program. 
Auxiliary Relays Area 448 bits AR0 to AR27 Flags and bits for special functions, state is 

retained after power loss. 
Link Relay Area 1024 bits LR0 to LR63 Used for data links - networking. Can be used 

generally if no network is present. 
Timer/Counter Area 512 TC0 to TC511 Timers and counters share this range, ensure 

you do not give a timer and counter the same 
address eg T10  &  C10 

Data Memory Area 1 1000 words DM0 to DM999 Used for storing values 
Data Memory Area 2 2600 words DM1000 to DM2599 Special IO Unit area 
Data Memory Area 3 3400 words DM2600 to DM5999 Used for storing values 
Data Memory Area 4 656 words DM6000 to DM6655 PLC use 
 
Useful addresses: 
Description  Address 
First Scan   253.15 
On    253.13 
Off   253.14 
1sec Pulse  255.02 
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Appendices:   A 
 
 
 
Tokens & Dongles: 
 
 
Syswin version 3.3 can be provided on CD, during installation it asks for a code which is the software 
license. After installation Syswin will work without having a Token or a Dongle. 
 
However, Syswin versions 3.0 – 3.2 are installed from floppy disk and require either a Token or a Dongle 
to be installed on the Laptop. 
 
Token: 
Syswin Tokens are supplied on a Red floppy disk, the token is a piece of software that is installed on the 
laptop during activation. Every time Syswin is booted it first looks for this software and if present it allows 
Syswin to fully run, otherwise it runs in Demo mode which will not allow you to connect to a PLC nor save 
any programs that you may write in Demo mode. 
 
To install a Token from windows Syswin do the following:- 
 

• In the windows Start menu select Programs and then Syswin, and Syswin Token Mover 
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• Token mover will then appear. 

 
 
The 4 large buttons on the left hand side will illuminate and guide you through the process of Token 
installation, ensure the Red Disk is in the Laptop floppy drive and press the top button, this will then check 
the floppy for any valid tokens, the number of tokens found will be displayed on the right. 
 
The next button will then flash and this will check your hard drive on the Laptop for any installed Tokens, 
if no tokens are found then press the Activate Syswin button and the Token will be moved from floppy disk 
to the hard drive. Syswin is then ready for use. Close down Token Mover. 
 
If there is a Token on the Laptop hard drive you can remove it by pressing De-Activate Syswin, and the 
Token will be moved back to the Red Floppy Disk. 
 
WARNING:  Tokens can be lost on the Hard drive, if certain disk managers are run and especially if the 
Laptop fails to load windows and you have to format the hard drive. Tokens can be retrieved via Dos (see 
Advanced Omron Course). 
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Dongle: 
 
Via Start Menu Programs, select Dongle Installer in place of Token Mover 
 

 
 
The Dongle is a piece of Hardware that is connected to the parallel port at the rear of the Laptop, the 
Dongle has a throughput connection that allows it to be inserted between Laptop and Printer, providing a 
printer has been connected to the Laptop. 
 
Ensure the Dongle is fitted to the port and activate Dongle Installer, click on Scan for dongle, once it has 
found it, then click Activate. Dongle Installer will then re-write the Autoexec.bat file for next time the 
Laptop is re-booted. Note: you do not have to have the Dongle fitted every time you boot the laptop, as 
long as you connect it before you start Syswin. 
 
The Dongle is more reliable than a Token and is safe should the laptop hard drive fail. However it can be 
mislaid, so keep it safe it is expensive. 
 
 
 
 
 
 
 
----------------------------------------------------------END 


